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Disclaimer
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herein; nor for incidental or consequential damages resulting from furnishing this
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Trademarks

Microsoft, Windows XP and VISTA are registered trademarks of the Microsoft
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Customers should ensure that their use of this product does not infringe upon any
patent rights. Trademarks mentioned in this publication are sued for identification
purposes only and are properties of their respective companies.

DOC NO: ED-201-001 -2-
REV:v.1.0



USB Server Hub User Manual

Table of Content
INEEOAUCTION ...ttt ettt st sb et sttt et et e sbeesaeeaees 4
FFRATUTES ...ttt ettt b e bbbt e bbbt sab e e bt e bt et e bt e b e et eaees 4
INSEAITATION. ...ttt et st eb et ettt ettt et e b e e 5
RUNNING PrOIamM..c...eiiiiiiiiieeie ettt et sttt e et e et et eenseeenseens 6
Main DiIalo@ BOX...ioiuiiiiiiiiiie ettt et te e 7
Status of USB Server Hub and DeviCes..........cccvviieiiiiieiiiieeiee et 8
ACCESSING @ DEVICE ..ottt et 13
Server CONTIZUIATION. .....cc.ciiiiiiiiiiiieeie ettt s sttt ae 15
Configuration with Web-based Ul...........cccoiiiiiiiiiiiiic e 16
Configuration with the UtHIEY........cociiiiiiiiiiii e 25
POIING INTEIVAl.......oooiiiiiiiii e 29
LANGUAZE .....oouviiiiiiiiii e 31
SCATCR...c ettt ettt e a e ea et et e e e nanee 32
VIBW 1ttt ettt h e bt s h e bttt ea et a e ettt e a e bt et e e bt e bt e bt e bt e bt e nnee 33
DEVICE DTS .. .eeiieeeitteee ettt ettt et ettt e bt et aae e st e s e 35
HEIP =3 ADOUL ...ttt et e sttt et e ettt esae e 37
TECHNICAL SUPPOTT ..ttt ettt ettt e bt e bt eeate e saeaesneeeaae 38
DOC NO: ED-201-001 -3-

REV:v.1.0



USB Server Hub User Manual

Introduction

The revolutionary USB Server Hub utilizes technology that streamlines and enhances
functionalities between USB devices and multiple PCs. Current solutions from other
companies provide minimum functionalities at high costs. They use significant amounts
of resources and effort to achieve the required features, whereas the USB Server Hub
utilizes significantly less resources for more features. Most solutions allow printer-only
peripheral devices. However, USB Server Hub allows you to use a multifunction combo
device, such as a printer-scanner or printer-fax all-in-one! Another added benefit is that
you can connect multiple printers/scanners/faxes to the USB Server Hub. These are just
some of the features that make our product one of the standards today. The USB
Server application provides a user friendly interface between you and the USB Server
Hub, enabling you to monitor, manage and use the convenient and powerful functions
provided by USB Server Hub.

Features

e (Centralized remote USB Server Hub Management
e (Centralized remote USB Server Hub Status Monitoring
e (Centralized remote USB Device Management

e (Centralized remote USB Device Status Monitoring

System Requirement (Suggestion)
XP System:

CPU: P4 1.7 GHz equivalent or better
Memory: 512MB or more
VISTA System:

CPU: P4 3.0 GHz equivalent or better
Memory: 1GB or more.
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Installation

To install the USB Server Hub program, please double click the USB Server Hub setup
file. A dialog box should pop up to prompt you to choose desired installing language.
There are two choices: English and Traditional Chinese.

Choose Setup Language £3]

@ Select the language for this installation from the choices below.
]

| Englizh [United States)

[ ak. l [ Cancel I

After choosing the language, click on OK. The InstallationShield Wizard will start

automatically.

PhoenixInstall - InztallShield Wizand

Welcome to the InzstallShield Wizard for
PhoenixInztall

The Ingtall5hield wizard will inztall Phoenisl netall an wour
computer. To continue, click Mesxt.

Cancel I

Please follow the instructions of the wizard to complete the installation process.

Please reboot the system as requested by the installer when the process ends,
otherwise the software might not work properly.
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Running Program

To start the USB Server Hub program, please double click the shortcut icon of the USB

Server Hub on the Desktop.

This brings up the main dialog.
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Main Dialog Box

OSE Server Huh E]'E'[E'

File Wiew Help

sl= | USE Server Hub-222126 (192 166.0.54)
(MSilicon-Fower USE Mass Storage Device

search ‘ ‘ Config

The main dialog box of USB Server Hub is shown above. This is what you would see at
program start up. It is consisted of a Control Menu (File, View and Help), a tree view, a
Search button to get the current status of all USB Servers and devices on the network,
and a button that toggles between “Config.” and “Connect” depending on the node you
select on the tree view. It toggles to “Config.” when a server is selected on the tree view
and to “Connect” when a device is selected. The tree view displays the all the USB

Servers and devices your PC has access to.
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Note: You will be allowed to set an alias name for each of the servers on for easy recognition. The
alias name with its IP address will be displayed on the tree view. The way to set alias name will be

described in the “Config.” section below.

Status of USB Servers and Devices

The tree view also tells you the status of all the USB Servers and devices that are
accessible to you. Each of USB Server is either accessible or inaccessible. An
inaccessible server is either disconnected from the network, powered off or suffers other
technical difficulties that prevent it from being accessed by your PC. Inaccessible server

will not show up on the tree view.

However, the devices have several kinds of demonstrated status:
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Ready

OSE Server Huh
File Wiew Help

sl= | USE Server Hub-222126 (192 166.0.54)
(MSilicon-Fower USE Mass Storage Device

search ‘ ‘ Config

Each status is represented by an icon of different color. A device with “Ready” status is
indicated by a square Green icon as shown in the picture above. This green icon

indicates that the device is unoccupied and ready to be connected.
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Occupied by Yourself

0SB Server Huh
File Wiew Help

= ] USE Server Hub-222125 (192.168.0.54)
] (1S ilicon-FPawer USE Mass Storage Device

Search ‘ ‘ Disconnect

When you are “Connected” to a device, the green icon turns into an Orange icon to
signify the establishment of the connection.
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Occupied By Other User

IEE Server Hub
File Wiew Help

server Hub-222126 (192 168.0 54)

E miSilicon-Power USE Mass Storage Device

search ‘ ‘ Config

The Red icon indicates the device is occupied by another user and you can not
connect to that device at the moment.

DOC NO: ED-201-001 -11-
REV:v.1.0



USB Server Hub User Manual

1: Device on Different Segment
Blue icon indicates that the server’s IP address is on a different network segment as
from yours. You can NOT connect to a device attached to such server.

# : Unsupported Device
Some of the devices are not supported by USB server Hub. Such device will be
identified by a red X icon. Of course, connecting to an unsupported device is not

allowed.

f: Self Occupied with Error
When an error happens on the device you are connected to, you will see a small
exclamation mark appears at the right lower corner of the icon as show above. This
problem could be that the device is a printer and it is out of ink or out of paper.

I: Occupied by Others with Error
When you see this red-with-exclamation icon, it signifies that a problem occurs on the

device that is occupied by another user.

Q: Free with Error
A green icon with exclamation mark indicates that this device is not connected by

anyone but does have some type of problem such as out of ink.

Of course, any problem indicated by the exclamation mark would prevent the
device from working properly. Please resolve the problem before you continue

using the device.
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Accessing a Device

OSE Server Huh
File Wiew Help

server Hub-222120 (192.168.0.54)

(MSilicon-Fower USE Mass Storage Device

search ‘ ‘ Config

To connect to a USB device, please select it on the tree view and click on “Connect”
button or double-click on it. This process might take a few seconds up to a minute,
depending on the complexity of the device.

Once connected, you can use the USB device as if it is connected to your PC
directly with a USB cable.
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If you select a connected device on the Ul, you can see that the Connect button is
changed to Disconnect:

0SB Server Huh
File Wiew Help

= ] USE Server Hub-222125 (192.168.0.54)
] (1S ilicon-FPawer USE Mass Storage Device

Search ‘ ‘ Disconnect

Clicking on the button disconnects you from the selected device. Once you see the icon
turns green, the device has been disconnected and other users will then be able to

connect to it.
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Server Configuration

OSE Server Huh
File Wiew Help

server Hub-222120 (192.168.0.54)

(MSilicon-Fower USE Mass Storage Device

search ‘ ‘ Config

We allow the users to configure the settings of the USB Servers via the web-based Ul.
Select the target server on the tree view and then click on the “Config.” button or right

click on the server and select “Config” option on menu to bring up this configuration Ul.
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Configuration with Web-based Ul

Your default web browser will pop up and take you into the web-based configuration Ul

of the server.

Leading the Evolution in
Miniaturized Server Design

Device Status
Network

Reset Device 1USB Server Hub

Factory Default Manufacturer Generic
Firmware Update Model . .USEI Server
Password Change Firmware Version Y 100,070

Server UP-Time 0 days, 0 hours, 12 minutes, 24 seconds.

Device Name | Silicon-Power USE Mass Storage Device
Link Status Busy

Device Status Ready

Current User ;speed

Device Name
Link Status
Current User

Device Name
Link Status
Device Status
Current User

Device Name
Link Status:
Device Status
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This is the main page of the configuration Ul. You can see the important information
about the USB Server and the device(s) connected to it. The 6 links at the left-hand side
each represents a function. Clicking on “Device Status” brings you back to this page,
and the 5 other links take you to pages with different functions.

Network Information/Setting

Leading the Evolution in

. 4 V. * Miniaturized Server Design
4 7 :

I Network

s o evowwomaten
1P Setting Automaic (DHCP}

Factory Default P Address 192168.0.54

Firmware Update Subnet Mask | 255,255 255 0

Password Change MAC Address 00:00:33:22:21:25
~ NetworkSetting
DHCP Setting | Emakle v
IP Address j1s2 |lies |0 [[s |
Subnet Mask 25 |55 Jzss o |
Server Nams lUSB'Ser\rerHub
Password | | *Must Provide If Available®

This page displays the current network setting of the server and provides links to the
pages where you can perform special actions. You can change the network setting
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according to your need. However, please note that if you would like to give this
server a static IP, please disable the DHCP option. Once you are done, please click
on the “Submit” button and reboot the server.

NOTE: A Server with busy device(s) connected is prohibited to be configured to prevent
interruption of any on-going tasks.
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Server Reset

Clicking on this link takes you the page show below:

a‘_'.:dsﬁng the Evolution in
Miniaturized Server Design

W5 *

Reset Device

Reset Device
Factory Default T
Firmware Update

Password Change

Device Status

Password ‘

|*rf1|_|st Frovide If Available*

With the “Reset Server” button you can reboot the server. However, if there is a
password, you must enter it for this function to work. Password is by default blank. So,

unless a password is explicitly set, you do not have to enter anything for the reset
function to work.
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Factory Default

Clicking on this link takes you the page where you can restore the server’s settings back
to default:

Leading the Evolution in

/' i o b . Miniaturized Server Design
i { . F 5 ’

= Factory Default
Device Status

o o reenpe

Reset Device Pas - d: |

Factory Default | Fartory Default
Firmware Update )

Password Change

|"Must provide If Available®
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Again, the password is not necessary if no password is set. Just leave the field empty
and click on the “Factory Default” button to restore the factory default settings.
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Update Firmware

This link takes to the page where you will be able to upload the latest firmware for the
server:

] Leading the Evolution in
& i 4 - Miniaturized Server Design
U}

14

I Firmware Update

e o Password | | *Must Provide If Available*
Factory Default —
ey ' L=
irmware Update - = :
Submit || Clear
Password Ehange L -

Please first click on the “Browse” button to browse to the firmware you would like to

upload and then click on the “Submit” button to update the firmware. You do not need to
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provide a password for this operation if there is not password set. Please just leave it
blank.

Change Password

Clicking on this link takes you to the password update page below:

Leading the Evofution in

Miniaturized Server Design

san

N Password Change

C amsweOmne

———

Factory Default : |
New Password | |

Firmware Update ;

Confirm Hew Password |
Submnit

*Must Provide If Available®
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To change the password, you must enter current password, input new password and re-
input new password for confirmation and then click on “Submit”. If you are setting the

password for the first time, you don’t have to provide current password.
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Configuration with the Utility

Another way to configure the server is via the configuration dialog of PB2. To bring up
the configuration dialog, please RIGHT-CLICK on the server you would like to configure,

0SB Server Huh
File Wiew Help

search ‘ ‘ Config

And select the “Setting” option. If a protective password has been set, this option brings

up the following configuration dialog.
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E

Metwark Settings
Sorver Mame: | -SB SerserHub

[“IDHCF

IF Address:

Subnet;

et Cancel ]

l Backup Firmware l
l Update Firmware l
l Change Password l
l Festart Sarver l

| i ] [ = l

You might be prompted to enter password if a password has been set. If not, you will
immediately see the above dialog.

Set Sever Name and IP Address: these fields allow you set the server name and IP
address settings. If you are changing IP address, please make sure you know what you

are doing.

NOTE: You can apply this function to a server under different network segment.
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Backup Firmware: this function is a fail-save mechanism for the Update Firmware

function.

Backnp Firmware

Backup File: | CriDocuments and Settings'200901011625.bin

Use the Browse button to choose where you want to save the backup file. Click on
Submit to start. You can backup the current firmware of your server and save it on your

PC in case you updated the latest firmware and want to revert back for some reasons.

Update Firmware: update firmware with this function.

Mpdate Firmware E“E'

Update File:

Use the Browse button to choose the firmware to update. Click on Submit to start.

Change Password: Simply enter the new password and enter it again for confirmation.
Click on Submit to change.
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Change Pazsword

Mew FPassworg; | e

Confirrm Mew FPassword; | s

Reset Server
This button reboots the server. Please note that this function will not work if the server

you attempt to reset has a device connected to it and the device is occupied by a user.
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Polling Interval

The USB Server Hub program periodically polls your network to find out the status of
all the connected servers and devices. Any change on the status of servers and devices
will be updated to the tree view in the main dialog box. The default setting is that the
program would perform this polling every 30 seconds. To change this polling interval,
click on the File -> Settings -> Polling Interval option on the control menu:

OEE Server Huh

W:5.0.5)

v Feceive Dizconnect Request storage Device

search ‘ ‘ Config

Then you should see this dialog box pops up:
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Polling Interval E]|§| E'

Configuration

Seconds

Input 0to stop polling.
binimurm input is 20 seconds.

As indicated on this dialog box, you must input a minimum of 20 seconds. Set it to 0 to

disable this function. Click on Submit to allow the new interval to take effect.
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Language

USB Server Hub now supports two languages: English and Traditional Chinese. To
toggle between the languages, please go to File -> Settings -> Languages option and

select the desired language.

IEE Server Hub

IZIEN View Help
Polling Infersal

Chit

v Feceive Disconnect Feguest Francaiz (French)
Dentech (Grermmain)
Italiano (Ttalian)
BHAEE (Tapanes=)
Polskd (Polish)
AHCAMRA AR (Rusdan)
B D (Simplified Chiness)
Espanal Spamish)
Fra T (Traditional Chiness)

search ‘ ‘ Config

Simply select the desired language to change the UI's displaying language.
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Search
When you are in need of knowing the status of all the servers and devices immediately,
use the Search function:

OSE Server Huh
File Wiew Help

(MSilicon-Fower USE Mass Storage Device

search ‘ ‘ Config

Clicking on the “Search” button triggers the program to immediately poll the network for
the status of all the servers and devices. The result will be updated to the tree view.
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View

The tree view in the main dialog has two display modes: “Servers and Devices” mode
and “Devices Only” mode. The default setting is “Devices Only” mode. You can toggle

between these two display modes with the View option on the control menu:

0SB Server Huh
File BGTETS Help

v Bervers And Devices
TrenconFower USE Mass Storage Device

search ‘ ‘ Config

Servers and Devices view
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IEE Server Hub
File Wiew Help

Search ‘ ‘ Connect

Devices Only view
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Device Details

When you right click on a device on the tree view, a menu will pop up:

USB Server Hub =3

File Wiew Help

Search ‘ ‘ Connect

When you select the “Details” options, some detailed information about the selected
server/device respectively will be displayed in another pop-up dialog box.
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Silicon-Power USE Masz: Storage Device

Status

Status:
Ocoupied by Mame:

Dccupied by IF:

Details

hManufacturer:

Fodel:

Clueue Mame:

Connected
speed

192.168.0.37

Silicon-Fower

LISE kass Storage Dewvice

Ok
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Help -> About

O3B Server Huh
File View Bz

Ahout
= Ust oerver Hub-222125 (192 168.0.54)
B} (1)Silicon-Power USE Mass Storage Device

Search Disconnect

About option brings up a dialog box with legal and other relative information displayed:
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Abont EI

LISB Server Hub
YVerzion 3.0.1.2 , April-3-2004

FShd DILL
YVerzion 2.0.5.1 , December-08-2008

Technical Support

If you have any questions that the Troubleshooting section failed to address, please visit
your dealer for further help. We have Technical Support working non-stop in order to

provide the best support we can for our customers.
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